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November 2017 Update (Build 84)
Version 20.6.84 includes the following software fixes:

n In the 6-6-1 Purchase Orderswindow, you no longer receive an error ("conflict with enhanced foreign key
constraint"), which occurred in some circumstances when you saved a POwith a part number.

n Entering a duplicate bid item on the 6-10 Unitary Proposals grid no longer generates a fatal error .

n You now receive an error message if an invalid date exists in a grid when you save changes in a record or a
window. Previously, if the grid included an invalid date, you could not save changes, and you received no
message indicating any problem with the date or that your changes were not saved.

n In the 3-3-1 Cash Receiptswindow, entering a number in the Invoice# box and pressing F4 no longer
triggers an error.

n In the 5-2-2 Payroll Recordswindow, you no longer receive an error when you try to save a record that
includes a negative total per diem.

n The 11-3 Dispatch Boardwindow now displays the service area for unassigned work orders, if you include
the service area’s description in the work order display.

n In the 1-7 General Ledger Accountswindow, the Subaccount window once again shows period balances
and budgets.

n In the 9-5 Takeoff window, you no longer receive the error "Object reference not set to an instance of an
object" when exporting Service work orders.

n When emailing a report (for example, a 3-2-21 Receivable Invoice), you now run the spell checker in the
Email Distributionwindow by clickingEdit > Spell Check. (Previously, the spell checker ran by default.)

n When using Lookup windows inmulti-selectionmode, you can press the [Enter] key to select the item on
the highlighted row.

n Duringmigration, you no longer receive an error ("Error reading FLDLIB on table 'wrkcmp' and field 'inactv'")
if themigration process needs to create an UnknownCompCode record for a workers compensation code
that was deleted in version 19.

n On theHome & Resources tab, when you click theHelp Topics link, you no longer receive a "404 - File or
directory not found" error.

Fixes for the Canadian Edition
The following issues were fixed specifically for the Canadian edition:

n You no longer receive a fatal error ("Attempt to divide by zero") when you compute payroll for a record that
contains only a per diem. (This error occurred only if the record had no gross pay amount.)

November 2017 Update (Build 84)
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Enhancements in version 20.6
This section describes the new features and enhancements you will find in version 20.6.

We've been listening to you!
Sage thanks you for your product ideas! In version 20.6, we have incorporated the following top-ranking
suggestions. Later sections describe changes that require more detailed explanation.

When you preview a report on your screen, you can click a new Refresh option on the File menu (or
press F5) to update the report with recent information, rather than having to close and then reopen the
report window to load new report data.

Thank you, Rhiannon T., for this suggestion.

You can print theAR Aging, SR Aging, andAP Aging reports by invoice date or by due date. This
means you no longer have to create custom aging reports for banks that do not accept the Aging by
Due Date report.

Thank you, Stefni G. and Don K., for this suggestion.

There are new combinedAR and SR Aging reports, which you can print by due date or invoice
date. If you are involved in both construction and services, you no longer have to print separate
reports for Accounts Receivable and for Service Receivables.

Thank you, Jeffrey C., for this suggestion.

You can now set records Inactive, enabling you tomaintain records in your system even if you no
longer use them. Inactive records do not appear on reports or in lookup windows. Also, because Sage
100 Contractor prevents entry to inactive records, you cannot inadvertently process entries that use
inactive records.

Thank you, Rhiannon T., Vicki H., Melissa C., My L., Jim Sc., Walt M., Kurt B., and JoeMcG. for
this suggestion.

You can use the Tab key, as well as theEnter key, to move efficiently from cell to cell in data entry
grids.

Thank you, Brian P., for this suggestion.

In the 3-5 Jobswindow, new A/P Invoices, S/R Invoices, andProposal buttons at the bottom of
the window enable you to display additional information without leaving the 3-5 Jobs window. Also, in
the 3-6 Receivable Clientswindow, a new Service Quotes button displays a list of service quotes.

If your computer screen is not wide enough to display all the access buttons, you can use new
buttons to scroll back and forward to view them.

Thank you, Jennifer F., Amy N., Rhiannon T., andGreg C., for these suggestions.

You receive a warning if you attempt to post Payroll or T&M invoices to a period that does not match
the check date or invoice date, respectively.

Thank you, Angela N., Jennifer S., Charlene D., and Vickie S.

You can track the Sold Date for equipment in 8-3 Equipment.

Thank you, Rhiannon T., for this suggestion.

Enhancements in version 20.6
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When you log on to Sage 100 Contractor, the program now caches a list of the databases to which
you have access, and displays this list in the Company List box when you log on subsequently. This
updated log-on process is more efficient, especially if you have a large number of companies and
archives.

Do you have a product idea you want to share with us?
Wewant to hear it!

To suggest a product enhancement when you're working with Sage 100 Contractor:
1. On the Sage 100 Contractordesktop, click theHome & Resources tab > Submit Product Idea.

2. Log in to the Sage 100 Contractor Ideas site (or sign up).

3. Describe your idea.

4. (optional) Browse through others' suggestions, and vote for the ones you love!

Or visit https://www5.v1ideas.com/TheSageGroupplc/Sage100Contractor any time you're online!

New Server Management tools
In version 20.6, Database Administration provides new server management tools that you can use to create a
new SQLServer instance, to move your Sage 100 Contractor companies to a different SQL Server instance,
and to remove an existing SQL Server instance.

You Can Set Records "Inactive"
If you are a company administrator, you can now designate records Inactive. For example, you canmark
Inactive records that you no longer want to use, but cannot delete because they are referenced by other,
current records.

Note: To change Inactive settings, your login ID must be assigned the Company Admin role in the 7-2-
2 User List. You do not need to select theOpen company with Administrator rights option when you
sign into the company.

Sage 100 Contractor prevents entry to inactive records, so you cannot inadvertently process entries using
them. For example, you cannot use an inactive cost code on a new purchase order or change the code on an
existing record to an inactive cost code.

The 9-5 Takeoff and the 10-3 Schedules lookup windows do not display inactive records. Also inactive
records do not appear in data control boxes, and they are not visible when you search for records using the F9,
Page Up, orPage Down keys.

Note: Inactive records do not appear in lookup windows by default, but you can display them if you
choose to do so. (For information about displaying inactive records, see "Viewing Inactive Records" on
the facing page.

Enhancements in version 20.6
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Designating Inactive Records
You designate Inactive records in the following windows by selecting new Edit > Inactive Record for a
selected record:

1-7 General Ledger Accounts

General Ledger Subaccounts

3-5 Jobs

3-6 Receivable Clients

4-4 Vendors

5-2-1 Employees

8-3 Equipment

9-2 Parts

9-3 Assemblies

In the following windows, which display records in a grid, you enterY (for Yes) in the Inactive column to set
the record for the selected row Inactive:

5-3-2Workers' Compensation

5-3-4 Paygroups

6-5 Cost Codes

If it is necessary to change the Inactive setting later, you simply clear the Inactive Record selection on the
Edit menu or the grid.

Viewing Inactive Records
From time to time, youmay need to check which records of a given type aremarked Inactive. For example,
when adding a new cost code, to check which codes are already in use, you need to view inactive codes. You
can display a list of Inactive records in a couple of ways:

For records that display a single record at a time (not in a grid format), you can view all Inactive
records of a selected type by opening the associated lookup window, and then clickingOptions >
Show Inactive Records.

A check mark in the Inactive column indicates that a record is Inactive.

You Can Set Records "Inactive"
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In windows that display records in grid format, you view Inactive records by selecting theShow
Inactive Records check box below the grid. The following windows use a grid to display records:

5-3-2Workers' Compensation

5-3-4 Paygroups

6-5 Cost Codes

Note: A Yes entry in the Inactive column indicates that a record is inactive. If you are a
company administrator, you can change this entry to change the status to and from Inactive.

Changing the Inactive Settings for Multiple Records at the Same Time

For windows that do not display records in a grid, you can use the lookup windows to set or clear the Inactive
setting for multiple records at once. For example, in the 3-5 Jobs window:

1. Open the job number lookup window. (Click the down arrow beside the job number data control.)

2. In the lookup window:

a. Click Options > Edit Inactive Setting.

b. Select or clear the check marks in the Inactive column to change the Inactive setting for the records
on the selected rows.

More efficient log-in
When you first log in to Sage 100 Contractor version 20.6, the program creates and stores a personalized list
of the companies to which you have access rights, including archived companies.

The next time you log in, Sage 100 Contractor displays in the Company List window only companies from
your personal list—provided those companies still exist on the database server—making the log-in process
faster.

The program automatically updates personal company lists when companies are added, deleted, renamed or
archived in Database Administration. However, if you notice that your list includes a company that you know
has been deleted or renamed, or does not include a new company, click theRefresh Company List link in
the Company List window to recreate your personal company list, removing obsolete companies and inserting
the new ones.

Replace Cost Codes, Vendors, Tasks, or Inventory Locations
in a takeoff
A new replacement function in the 9-5 Takeoffswindow enables you to replace cost codes, vendors, tasks, or
inventory locations in takeoffs quickly and efficiently. For example, if your takeoff template contains “Inactive”
cost codes, vendors, tasks, or inventory locations, you can easily replace these codes with active ones.

Enhancements in version 20.6
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To replace codes in a takeoff:
1. In the 9-5 Takeoffswindow, click Update > Replace.

2. In theReplace Cost Codes, Vendors, Tasks, or Inventory Locationswindow:

a. Select the type of item you want to replace in the takeoff. (You can replace cost codes, vendors,
tasks, or inventory locations.)

b. In theOriginal Value box, select the value that you want to replace.

c. In theReplace with box, select the new value to use or type it.

3. Click [Replace].

Caution! You cannot undo this action, although the changes do not affect the database until you save
the takeoff. If you close the takeoff without saving, the replacement data is lost.

When you click [Replace], the program replaces the specified original values for all takeoff grids for the
selected job.

New Aging Reports

Combined Accounts Receivable and Service Receivables reports
If you are involved in both construction and services, you no longer have to print separate reports for Accounts
Receivable and for Service Receivables. You can print the following new combinedAccounts Receivable
and Service Aging reports by due date or invoice date, as indicated:

81—Combined AR/SR Invoice Aging

86—Combined AR/SR Invoice Aging~Land

91—Combined AR/SR Invoice Aging~Aged by Invoice Date

96—Combined AR/SR Invoice Aging~Land; Aged by Invoice Date

You can print these locked reports using either the 3-1-3 Receivable Aging or the 11-1-3 Service Aging
report printing windows.

Print New Accounts Receivable Aging Reports by Invoice Date
You can print new AR Aging reports by invoice date. These new reports are:

51—AR Invoice Aging~Aged by Invoice Date (locked)

56—AR Invoice Aging~Land; Aged by Invoice Date (locked)

61—JobCurrent Aging~Aged by Invoice Date (U.S. only)

62—Job Current Aging~Alpha; Aged by Invoice Date

66—JobCurrent Aging~Land; Aged by Invoice Date

67—JobCurrent Aging~Land; Alpha; Aged by Invoice Date

71—Job Period Aging~Aged by Invoice Date

New Aging Reports
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72—Job Period Aging~Alpha; Aged by Invoice Date

76—Job Period Aging~Land; Aged by Invoice Date

77—Job Period Aging~Land; Alpha; Aged by Invoice Date

Print New Accounts Payable Aging Reports by Invoice Date
You can also print AP Aging reports by invoice date. The new reports are:

4-1-3-51—AP Invoice Aging~Aged by Invoice Date (locked)

4-1-3-56—AP Invoice Aging~Land; Aged by Invoice Date (locked)

4-1-3-61—Vendor Current Aging~Aged by Invoice Date

4-1-3-62—Vendor Current Aging~Alpha; Aged by Invoice Date

4-1-3-66—Vendor Current Aging~Land; Aged by Invoice Date

4-1-3-67—Vendor Current Aging~Land; Alpha; Aged by Invoice Date

4-1-3-71—Vendor Period Aging~Aged by Invoice Date

4-1-3-72—Vendor Period Aging~Alpha; Aged by Invoice Date

4-1-3-76—Vendor Period Aging~Land; Aged by Invoice Date

4-1-3-77—Vendor Period Aging~Land; Alpha; Aged by Invoice Date

Print New Service Invoice Aging Reports by Invoice Date
You can print the following new Service Invoice Aging reports by invoice date:

11-1-3-51—Service Invoice Aging~Aged by Invoice Date (locked)

11-1-3-56—Service Invoice Aging~Land; Aged by Invoice Date (locked, U.S. only)

11-1-3-61—Client Current Aging~Aged by Invoice Date (U.S. only)

11-1-3-62—Client Current Aging~Alpha; Aged by Invoice Date

11-1-3-66—Client Current Aging~Land; Aged by Invoice Date (U.S. only)

11-1-3-67—Client Current Aging~Land; Alpha; Aged by Invoice Date (U.S. only)

11-1-3-71—Client Current Aging~Aged by Invoice Date (U.S. only)

11-1-3-72—Client Current Aging~Alpha; Aged by Invoice Date (U.S. only)

11-1-3-76—Client Current Aging~Land; Aged by Invoice Date (U.S. only)

11-1-3-77—Client Current Aging~Land; Alpha; Aged by Invoice Date (U.S. only)

Assign banking categories to bank-related journal
transactions
You can now classify bank-related journal transactions as adjustments, checks, or deposits for bank
reconciliation.

Enhancements in version 20.6
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The new Banking Category field in the 1-3 Journal Transactions and 1-4 Recurring Journal
Transactionswindows lets you classify a bank-related transaction as a 0-Adjustment, 1-Check, or 2-
Deposit. The category you assign to an entry determines its classification in the 1-5 Bank Reconciliation
grid.

Tip: You can drill down from a record in the 1-5 Bank Reconciliation window, change the category for the
transaction, and save it. When you refresh 1-5 Bank Reconciliation grid, the record appears correctly in
the new category.

The new Banking Category field is always present in the 1-4 Recurring Journal Transactionswindow, but
it appears in the 1-3 Journal Transactionswindow only for new records and for existing records that use a 3,
4, 19 or 21 Source code (which are classified as adjustments by default).

When you post a record in the 1-4 Recurring Journal Transactionswindow, the Banking Category value is
passed automatically to the 1-3 Journal Transactions record.

Enhancements for the U.S. Edition

Improved vacation tracking
Version 20.6makes it easier for you to administer vacation for your employees. It can also help to prevent you
from paying out vacation (or paid time off) when the employee has not accrued sufficient time or if they have
reached a specifiedmaximum.

For example, suppose you establish amaximum vacation accrual of 1.5 times the annual accrual rate. If an
employee is entitled to 40 hours’ vacation per year, they would not be able to accruedmore vacation when
they have accrued 60 hours. When they take vacation, dropping their accrued vacation below 60 hours,
vacation begins to accrue again.

You use the 5-2-1 Employeeswindow and the 5-2-2 Payroll Recordswindow to track vacation accruals:

TheCompensation tab in the 5-2-1 Employeewindow includes new Accrual Maximum and Last
Year Carry Forward fields for vacation hours. Sage 100 Contractor uses these amounts as follows:

During payroll close, accrued vacation is copied to the Last Year Carry Forward field.

The 5-2-2 Payroll Recordswindow now displays accruedVacation available (in hours) for a
selected employee. You no longer need to refer to the employee record to obtain the vacation
available.

When you select an employee in this window, Sage 100 Contractor displays their vacation available,
provided their pay is subject to vacation accrual. Negative vacation available is displayed in red.

Note: Vacation available is displayed only for new or Open status records.

During the payroll final compute, when calculating an employee’s accrued vacation, the program
includes the vacation accrued and vacation taken in the current period, while respecting the accrual
maximum from the employee record. The employee will not accruemore than the stipulated
maximum. Also, Sage 100 Contractor warns you if vacation for the current payroll record would result
in negative accrued vacation for the employee. If you choose to skip the final compute for that payroll
record, the transaction is rolled back, and that payroll recordmaintains anOpen Status.

Enhancements for the U.S. Edition
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Fixes in Version 20.6
Fixes in the U.S. and Canadian Editions
Version 20.6 includes the following software fixes in both editions:

n You can again use Sage Advisor Update to install future software updates of Sage 100 Contractor.

n You can delete a subaccount that has no ledger activity.

n Recurring journal entries are no longer displayed automatically as adjustments in the 1-5 Bank
Reconciliation window. Now, when you record a bank-related transaction in the 1-3 Journal
Transactionswindow or a recurring transaction in the 1-4 Recurring Journal Transactionswindow, you
can use a new Banking Category option to specify whether to display the transaction as an adjustment, a
check, or a deposit in the 1-5 Bank Reconciliation window.

n In the 3-3-1 Cash Receiptswindow, you can save cash receipts even if the associated service receivable
invoice uses a long description (over 50 characters).

n When you compute payroll, if a local tax includes a locale differential, local tax is now computed correctly
for the resident locale when that tax rate is higher than the work locale.

n If youmove rapidly through the Timecard grid in the 5-2-2 Payroll Recordswindow, the Pay Rate field now
displays the correct pay rate when the row uses a Paygroup. (Previously, on rare occasions, the rate would
be the employee’s standard rate and sometimes it would be zero, and amessage would indicate that a
change was occurring.)

n The 5-1-5 Workers Comp Report reports overtime correctly when you run the report without criteria.

n The 5-1-5-21 Workers Comp Report reports correct amounts if you select theSeparate Reports by Job
option when the report includes payroll records that have no timecard lines and an overriddenWorkers
Comp calculation.

n When you pay salaried employees using thePiece Pay orMisc. Pay pay type in addition to their salary, the
Workers Comp report now includes the salary as well as the wages from the Piece Pay andMisc. Pay time
card lines.

n You can now use theChange Posted Payroll Periodwindow (available from theOptionsmenu in the 5-
2-2 Payroll Recordswindow) to change the posting period for payroll transactions that were posted in a
summary batch. A new option, For records posted in summary, select a payroll posting batch is
available if there are summary payroll batches in your system.

Note: Youmust change the period for all the records posted in the batch.

n You can now use up to 999 in theAbsence# field to define absence reasons. (You define absence reasons
in theAbsence Reasonswindow, which is accessible from the Absence field In the 5-2-2 Payroll Records
window and the 5-5-1 Daily Payroll Entry window.)

n In the 5-2-4 Payroll Checkswindow, you can print payroll check reports that include paygroup information
when the employee has worked inmore than 19 different paygroups.

n When generating direct deposit files, the 5-2-5 Direct Deposit File Manager no longer includes payroll
records that have 0000 as the check number.

Fixes in Version 20.6
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n The 6-1-5 Current Cost Summary report now displays the correct values in the This Period columnwhen
you print the report for a range than spans more than two years .

n Committed Cost Reports (6-1-12-21, 6-1-12-31, 6-1-12-41, 6-1-12-51, and 6-1-12-61) andHome Builder
Reports (6-1-13-21, 6-1-13-26, and 6-1-13-41) now include negative quantities if they exist on the included
POs.

n Typingmultiple lines of text in theMessage field of the 6-11-2 Requests for Information or the 6-11-8
Correspondencewindow no longer adversely affects performance. The spell check is delayed until you
leave these fields.

n In the 6-11-7 Punch Listswindow, you no longer receive an error if you try to insert a row in a punch list
when there are hidden rows.

n You no longer receive an "Out of memory" error when you open the 7-4 Contact Manager. If you have an
exceptionally large number of contacts (over 10,000), you receive amessage suggesting that you filter the
list by marking unused clients, jobs, and vendors Inactive, or that you filter the list in a variety of ways to
reduce the number of contacts in the list.

n The 7-4 Contact Manager no longer shows blank contact rows in the grid.

n When you subscribe to the Transaction date doesn't match the posting period program warning in the
7-6 Alerts Managerwindow, you no longer receive erroneous email alerts when the transaction date
matches the posting period.

n In the 9-4 Parts/Assembly Classeswindow, when you create a new class, collapsing and expanding
classes will not hide the new class.

n The 9-4 Part/Assembly Classeswindow no longer freezes when you try to expand a class that has
subclasses.

n In the 9-5 Takeoffwindow, when you add a new bid item ormodify theO/H orProfit Rates for an existing
bid item, and then you click Yeswhen prompted to update bid items, the program no longer updates the O/H
and Profit Rates for bid item 0-None as well as the new or changed items.

n When you print 3-1-4-24 Combined Statement reports using the Include Payment History option, the
statements now include the payment details for service invoices as well as AR invoices.

n In the 11-3 Dispatch Boardwindow, you no longer receive an error message when you email an
assignment to a technician if the work order Location field is empty and the email fields include client
equipment information.

n Archiving a fiscal year now works properly with LIFO or FIFO inventory when you have an inventory
allocation that simply moved inventory from one location to another without a price change. (In this
situation, no accounting transaction is created.)

n When archiving, if you select themaintenance option to remove jobs, the archive process no longer
removes jobs that have only payable payments for the current books.

n You can now use the advanced and/or option as criteria when generating reports, even when evaluating
character fields using this logic.

n When you print the 2-2 21 Balance Sheet report to Excel using theRound to Nearest $ option, the
Subtotal Equity/Capital cell uses the correct formula.

n When you create a calculated field for use in reports or queries, you can now perform mathematical
operations on numeric variables.

n When you display the properties for a check box type of custom field, the Field Type is no longer blank.

Fixes in the U.S. and Canadian Editions

Release Notes 10



n You can now use a check box custom field as selection criteria when printing a report.

Fixes for the Canadian Edition
The following issues were fixed specifically for the Canadian edition:

n For vendor EFTs, the letter "V" is prepended to the vendor# in theOriginatorCrossReferenceNumber
field. The V differentiates the vendor from the payroll record# in a payroll EFT.

Fixes for the U.S. Edition
The following issues were fixed specifically for the U.S. Edition of Sage 100 Contractor:

n In the 6-7-1 Subcontractswindow, the Subcontract Summary reflects proper Invoiced to Date and
Balance on Contract amounts when payable invoices posted against the subcontract include a deduction
for workers’ compensation.

Fixes in Version 20.6
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API for Third-Party Developer Products
This release provides the following enhancements to the API:

API Enhancements in Version 20.6
In version 20.6, the API now:

Supports custom fields, enabling third-party products to add custom fields and to add data to custom
fields through the API.

Blocks the use of Inactive records in new records and prevents changing an existing record to use an
Inactive-related field. (The returned error code is 14057.)

API for Third-Party Developer Products
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Upgrading from version 19.8?
New Microsoft SQL Server Platform
Although Sage 100 Contractor 2017 has the same look, feel, and functionality that you are familiar with, its
new SQL database structure affords much tighter security and an up-to-date technology on which to build
future releases. It also provides several other notable enhancements, including:

A new, separate Database Administration tool. You don't have to be an expert user of Microsoft SQL
Server to take advantage of its robust features! We designed Database Administration to optimize
your data for Sage 100 Contractor, for example, by keeping related data in expected locations and
creating backups automatically before performing certain critical processes. Many of its features are
not available through SQL Server Management Studio.

Significantly, Database Administration includes amigration utility that we have designed and tested
extensively to help ensure a smooth and painless transition to SQL Server.

We have relocatedmany administrative utilities and functions from themain Sage 100 Contractor
program to this new tool. However, we have boosted their capabilities considerably, and now provide
easily scheduledmaintenance and backup functions to help you to keep your Sage 100 Contractor
companies in good order.

In addition, Database Administration offers several powerful, new capabilities that enable you to
maintain tight security and exert fine control over user and program access to your SQL Server
instance.

For a comprehensive list of the utilities you will find in Database Administration, see “Database
Administration for Sage 100 Contractor”, later in this document.

Note: Database Administration comes with its own help system and a new Database and
Company Administration Guide to acquaint you with its features and to guide you in its use.

New views for creating reports with third-party report writers. Because the new views point to the
database tables, rather than pointing your reports directly to the tables, we encourage you to use
them when creating custom reports using third-party tools, such as Crystal Reports.

For example, in earlier versions, you would point directly to actpay.vndnme to include Accounts
Payable vendor names in custom reports. In the version 20.6 company database, this information
resides in dbo.actpay.vndnme. However, we recommend that rather than pointing directly to the table
name, you point to the field in the new view: Reports_v1.actpay.vndnme. Report views are located in
the Views folder in your company database.

Upgrading from version 19.8?
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Tip: A compelling reason to use these views is that they may not be affected by many types of changes
to the underlying tables, so future database changes will not necessarily "break" your custom reports.

Software and hardware required to support Microsoft SQL Server
Version 20.6 requires an instance of Microsoft SQL Server. You can download and useMicrosoft SQL
Express at no charge, or you can use the full version of Microsoft SQL Server. You can even start using
Microsoft SQL Express, and upgrade to the full version of Microsoft SQL Server later, if necessary.

When you first open the new Database Administration tool, the program tries to configure an instance of
Microsoft SQL Server with optimal settings for Sage 100 Contractor for you. If you do not already have an
instance of Microsoft SQL Server, you can let the Database Administration tool download, install, and
configureMicrosoft SQL Express for you.

Refer to Knowledgebase article 84502 for detailed information about supported operating systems and
software, and for minimum hardware requirements.

Database Administration for Sage 100 Contractor
The new Database Administration tool is intended for designated system administrators and company
administrators. You use it to set up andmaintain your company databases, and to select advanced settings to
manage communications with and access to your Microsoft SQL Server instance from other programs.

If you have used earlier versions of Sage 100 Contractor, several of these tasks will be familiar to you. For
example, Database Administration includes utilities for creating and deleting a company, backing up and
restoring company files, and archiving company data that you used in previous Sage 100 Contractor versions.

Database Administration for Sage 100 Contractor
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Important! Wehighly recommend that you use Database Administration, rather than SQLManagement
Studio®, to perform the database administration tasks listed below, even if you are an experienced SQL
Server user. Besides handling all the database tasks that you are likely to perform in a typical Sage 100
Contractor system, Database Administration was designed to optimize your data for Sage 100
Contractor, for example, by keeping related data in expected locations and creating backups
automatically before performing certain critical processes. In the rare event that you need to use SQL
Management Studio® to perform a task that is not provided in Database Administration, you should
contact Customer Support for assistance.

Database Administration includes the following database and company management utilities:

Create Company Based on Existing and Create Company create new Microsoft SQL Server
databases.

RenameCompany and Delete Company are convenient utilities when working with existing
companies.

Deploy Sample Company helps you install and refresh the sample data that comes with Sage 100
Contractor.

Tune UpCompany Databases performs various maintenance tasks to keep your database
functioning efficiently.

Back UpCompany Databases enables you to back up your data "on demand," whenever needed.

Restore Company from Backup restores a backed-up copy of your database.

Upgrade Company Databases prepares your SQL company data so that it is compatible with the
most recent version of Sage 100 Contractor 2017.

Migrate Company Data andMigrate Custom Reports transfers your version 19.8 company data and
custom reports to a new location for Microsoft SQL Server. Migrated files are located in shared
folders under \\ServerName\CompanyName, organized using a folder structure similar to earlier
versions.

Schedule Nightly Maintenance utilities enable you to schedule backup andmaintenance operations
for times when other users are not logged into the system. You can also select the number of
consecutive backups to keep.

Manage Company Admins/SQL Logins utilities enable you to set up or delete logins to the SQL
Server database, and to designate a user as a company administrator for a specified Sage 100
Contractor company.

Advanced Company Settings lets you specify how long to keep history about database changes for
each company, including details about changed records, such as the date and user ID of the
employeemade the change. Details older than the retention period you specify are cleared during
nightly maintenance. (This history is maintained in separate audit tables, which you can query using
SQL Server Management Studio.)

Advanced SQL Server Settings includes convenient, sophisticated access andmemory
management controls for your SQL database.

Advanced Backup Settings lets you specify a backup folder if you prefer not to use the default folder.
You can also specify the number of days to keep "on demand" backup files.
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For detailed information about these utilities and how to use them, see the Database Administration help or
refer to the new Database and Company Administration Guide.

Additional Changes for SQL Server
In addition to the new SQL database platform and the Database Administration tool, you should note the
following important differences from earlier versions:

Because each user must now identify themselves to SQL Server using a unique SQL login, there is
no longer a single Supervisor user. Instead, you designate as Company Administrators users who
require elevated privileges in Sage 100 Contractor.

Tip: You can copy supervisor preferences used in version 19.8 to individual users in the version
20.6 User List window.

When starting Sage 100 Contractor, you first log in to an instance of SQL Server using a new
Connect to SQL Serverwindow, and then you select your company and type of access from the
Company Listwindow.

If you need to change the type of access after logging into the company, you can return to the
Company Listwindow using theChange Company/Access link on the Sage 100 Contractor
desktop.

Note: If you want to log in as a different user, youmust close Sage 100 Contractor completely
first, and then log in using a different user name.

You no longer need to reindex your data after upgrading. Now, you use the Database Administration
tool migrate your data from version 19.8 and to update it in future.

Version 20.6 and subsequent releases are installed to a different location than version 19.8 and earlier
versions.

Having separate installation locations enables you to run version 20.6 and version 19.8 on the same
computer while youmigrate your data to the new version.

You need to install the License Administration application and activate the software on the same
computer as your version 19.8 license server, choosing the option to use the computer as the license
server for version 20.6. After installing Sage 100 Contractor on other networked workstations, point to
this machine as the license server.

For more information, see the Installation and License Administration Guide.

Notice about Supported Windows Operating Systems
Sage 100 Contractor 2016 supports Windows Server 2008 R2, and later versions of Windows. However, it
does not support Windows Server 2008 and Small Business Server 2008 because they do not support .NET
4.6.1, which this version of Sage 100 Contractor requires.

For current information about supported operating systems, Internet browsers, and other software, and about
system requirements for servers and client workstations, refer to our Knowledgebase article ID 84502,
available at https://support.na.sage.com/selfservice/viewdocument.do?externalId=84502.

Additional Changes for SQL Server
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Installing Sage 100 Contractor 2017
Installation of Sage 100 Contractor 2017 and upgrading your data involves a few more steps than in previous
editions because you need to install two additional components. You need to:

Install the Database Administration tool on themachine you will use as your server.

Create a SQL Server instance for Sage 100 Contractor. This process is simplified if you use the
option to downloadMicrosoft SQL Server and create an instance automatically when you first open

For detailed instructions on installing Sage 100 Contractor 2017, see "Chapter 3: Sage 100 Contractor
Installation," in:

The Sage 100 Contractor Installation and License Administration Guide (U.S. Edition)

The Sage 100 Contractor Installation and License Administration Guide (Canadian Edition)

Printable checklists help you get started
Two printable checklists are available to help you get started using Sage 100 Contractor 2016. Download
them from our website, print them, and then check off each step on the printed list as you complete the
necessary tasks.

Use theQuick Start Checklist to help you stay on track when you set up your company or migrate
your company from version 19.8. It provides an overview of all the important steps you should
complete to install version 20.6

Use the "Going Live" Checklist when you are ready to start using Sage 100 Contractor 2016 in a
production environment (rather than a test environment). It lists all the important steps you should
complete to "go live" with Sage 100 Contractor 2016.

Earlier Enhancements in Sage 100 Contractor (SQL)
Earlier versions of Sage 100 Contractor provided a wide variety of new features, including a number of
enhancements that our customers have asked for.

This section describes several of the important new features introduced in previous versions. It also provides
a comprehensive list of additional features, the details of which you can read about in the Release Notes for
the respective version. For more information, see "Summary of Enhancements in Earlier Versions of Sage
100 Contractor (SQL)" on page 26

Use new custom fields in most windows
With version 20.5, you can define an unlimited number of custom fields for most Sage 100 Contractor
windows.

Custom fields enable you to store additional information that you want to keep with Sage 100 Contractor
records. As a company administrator, you can add, edit, or delete custom fields for any window that supports
them. You can create custom fields for most types of records, except ledger transactions, accounts, daily
payroll, and recurring transactions, and you can create an unlimited number of custom fields for a window and
for your Sage 100 Contractor company.

Custom fields are not the same as the user-defined fields (UserDef1 and UserDef2) that comewith the
software. Custom fields aremore versatile than the limited user-defined fields.

Upgrading from version 19.8?
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Note: Windows that support custom fields include a new Custom Fields option on the Edit menu, and
an [Enter Optional Fields] button on the toolbar.

When you select theEdit > Custom Fields option or click the [Enter Custom Fields] button:

If any custom fields have been defined for the parent window, theCustom Fieldswindow opens.
You can display the custom fields and change the custom field values for a record you are working
with.

If no custom fields have been defined for a window and you are signed in as a company administrator,
theCustom Field Propertieswindow opens.

The following sections describe how you use these windows to create and view custom fields for your Sage
100 Contractor company.

About the Custom Fields window

The Custom Fields window displays a list of the custom fields that have been defined for the parent window.
You use the Custom Fields window to view or to enter values for custom fields that have been added to a
parent window.

If you sign in to Sage 100 Contractor as a company administrator, you can also add new custom fields or
modify or delete existing ones:

You click the [Add] button in the Custom Fields window to open the Custom Field Properties window
where you can define a new custom field for the window you are working in.

You click the [Modify] button to open theModify Custom Fields window.

In theModify Custom Fields window, use the icons beside the field you want to modify to:

Edit the properties of the field ( ).

Delete the field ( ).

Move the field up or down in the list ( ).

Tip: If you want to keep the Custom Fields window open while you work with a record, click
[Pin]. The window remains pinned to the top right edge of the parent window until you unpin it,
even if you close and then reopen the parent window later. To unpin the window, click [Unpin] in
the Custom Fields window.

Defining Custom Fields for a Window

If you log on as a company administrator, you can define custom fields for any window that supports them.
Sage 100 Contractor does not limit the number of custom fields you can define for a window or for your
company.

You use theCustom Field Propertieswindow to add, edit, and delete custom fields.
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Before you start

Make sure you are logged into Sage 100 Contractoras a company administrator. You can add, edit, or delete
custom fields only if you are logged in as a Company Administrator:

To add a new custom field:
1. In a window that supports custom fields, click Edit > Enter Custom Fields, or click theEnter custom

fields button on the taskbar.

If no custom fields have been defined for the window, theCustom Field Properties window appears
immediately.

If any custom fields exist for the window, theCustom Fields entry window appears. In the Custom
Fields window, click [Add].

Tip: If you want to modify or delete an existing field, you click the field in the Custom Fields
window, and then either:

Press F7 or

Click [Modify],

Then, on theModify Custom Fieldswindow, you click theEdit properties for this field button or

theDelete .button.

2. Fill in the fields in the Custom Field Properties window as follows:

a. In the Field Name box, type a unique name to identify the custom field, using six characters.

Note: You cannot save a custom field with the same name as an existing custom field that has
been defined for a window, and you cannot change the name after you save the custom field.

b. In theDescription box, type a brief description for the custom field, using up to 30 characters.

c. From the Field Type list, select the type of data this field will contain. For example, if you will use
the field to store a type of number, select Number.

Note: You cannot change the field type after you save the custom field.

d. Depending on the Field Type you selected in the previous step, fill in additional attributes for the
custom field:

Length. For Character field types, enter maximum number of characters (use up to 255
characters) that the custom field can accept.

Decimal Places. For Number field types, select the number of decimal places (0, 2, 4, or 6) that
numeric entries will use.
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Maximum Value / Minimum Value. If you want to track a standard currency value, you need to
set maximum andminimum values. Themaximum valuemust be no greater than 999,999,999
and theminimum value should be no less than -99,999,999, the default values for these fields.

Numeric fields must have amaximum value greater than zero. You cannot use the same values
for Minimum Value andMaximum Value.

Prompt. For all field types, type a prompt to help users understand what to enter in the custom
field when they are processing records.

Default Entry. For all field types, type or select (if a list is available) the entry to display as the
default for the field.

Character fields can accept default entries, but not "Next" or "Previous."

Date fields display the date that occurs the number of days you specify after the current date
("TODAY").

Check boxes can be selected, or not, by default.

e. Set other options as follows:

Require Entry. Requires an entry, or Sage 100 Contractor will not save the record.

Use Quick List. You can provide aQuick List control for a customer field by selecting the Use
Quick List check box.

Require List Match. Requires that the entry match an item on theQuick List.

Lock Quick List. Prevents users from editing aQuick List. Only a company administrator can
edit the information.

Lock After Save. Prevents users from editing the information after saving the record. Only a
company administrator can edit the information.

Require Unique. Prevents users from entering duplicate information. This is available for
indexed text boxes that let you enter character-based information.

Check Spelling. Checks the spelling when youmove to another text box or cell. If Sage 100
Contractor finds amisspelled word, it displays theSpelling dialog box.

Mixed Case. Allows text entry in upper and lower case.

Upper Case. Displays text only in upper case.

Lower Case. Converts entry to lower case text.

f. On thePermit Access to list, select the user groups that should have access to the field. If you do
not select any user group, all user groups have access.

3. Click [Save].

View Change History in Records
Many data entry windows in version 20.6 include a new View menu, with options that enable company
administrators to view the history of changes to a selected record.

This capability can be helpful when you need to determine the source or the timing of a change in a record.
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Notes:
The depth of the change history is determined by the retention policy set for your company in
Database Administration. History is retained for 180 days by default, but you can change the
retention period.

You do not have to log into the company with Administrator rights to view history, providing you
are set up as a company administrator in the 7-7-2 User List.

When you display a record in a window that has a View menu, you can select one of two options to view
history:

View > Record history.When you select this option, a separateView Historywindow opens,
displaying a list of all the changes to the current record.

Initially, the list summarizes all the changes to the record, showing for each change

The database table that was updated,

Whether new information was inserted or existing information was modified or deleted.

The date and time.

The login ID of the user whomade the change.

The ID of the computer where the change originated.

The application where the change originated (for example, Sage 100 Contractor, Database
Administration, or SQL Server Management Studio).

Tip: If there weremany changes, you can filter a long list to show only changes for a particular
table, user, or application.

To view the details of a particular change, click the row on which the change is listed. Sage 100
Contractor displays aHistory Detailswindow that shows, for each field in the record, the value of
each field before and after the change.

View > Field history.When you select this option, field entries that have changed for the current
record are displayed against a yellow background.

To view change details for a particular field, click the field, and then press [F12]. Sage 100 Contractor
displays a separateHistorywindow for the field that lists the ID of each person whomade a change,
the date of the change, the field values before and after the change, and the application where the
change originated.

Note: With View Field History turned on, you cannot edit the record.

The view history options are turned off when you close the window ormove to another record.

Note: Although the following windows include a View menu, some special conditions apply:

In 5-2-1 Employees, history is not provided for theACA tab.

In 5-2-2 Payroll Records, history is not provided for the theCalculations tab.
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Tag rows for follow-up in the 9-5 Takeoffs grid
You can tag rows in the 9-5 Takeoffs grid, marking them for future follow-up. When you tag a row, you can add
a note to remind you why you tagged the line (for example, “Check this number with subcontractor XYZ”).

Headers for rows that you have tagged in the takeoff grid display a red triangle, helping you to identify them.

To tag a row in the 9-5 Takeoffs grid:
1. Right-click any field in the row that you want to tag.

2. On the shortcut menu, click Add/Edit Row tag.

A Row Tag window appears. It identifies the bid item, phase, and row number of the row you are
tagging. It also provides space to enter a note.

3. In the Tag Note box, type the reason you are tagging this takeoff detail.

4. Click [OK].

To view a single tag note later, you can open the Row Tagwindow for the detail, just as you did to tag the
detail.

To view a list of all the tag notes for the entire takeoff, click the [RowTags] button at the bottom of the
window. In the Takeoff Row Tags for Job# window that opens, you can select a row tag, and then:

Click [Go to Row] to go to that detail in the takeoff grid.

Click [Remove] to remove the note and the tag for one or more selected rows.
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Correct the period of a posted payroll transaction
If you post a payroll transaction to the wrong period, you can use the new Change Period for Posted
Records option in the 5-2-2 Payroll Recordswindow to correct the period.

This procedure updates the existing record directly to move it to the new period, rather than reversing and
replacing the existing record.

Before you start

Note: Youmust log into the company as an administrator with exclusive access to use this feature.

To correct the period of a posted transaction:

1. Open the 5-2-2- Payroll Recordswindow.

2. On theOptionsmenu, click Change Period for Posted Records.

TheChange Posted Payroll Period window opens.

3. Enter criteria to select the payroll records that you want to change.

4. From theChange Period To box, select the correct period to which to post the payroll records.

5. Click [Preview Records] to view a list of the records that match your selection criteria, and verify that
these are the records you need to change.

If the list contains unexpected results, adjust the criteria until only the records you want to change are
included.

6. Click [Change Records] .
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Sage 100 Contractor:

Updates all payroll records that have a ledger reference, including Void records.

Updates the general ledger and job and equipment costs with the new period and fiscal year.

Recalculates the ledger balances.

Filter cost codes by Job and Phase in Lookup windows
When you search for cost codes in a lookup window, you can apply filters to include only the cost codes that
pertain to a specific job and phase or you can display all the cost codes you use for your company. A filtered
search is very efficient, especially if your company has a large number of cost codes and you are interested
only in cost codes for a particular job.

You can use three types of filters to search for cost codes:

All

Job

Job/Phase

When searching for cost codes, the filters that are available depend on the structure of the job and budget:

If a job has a budget, you can select a filter.

If the job has a budget but no phases, you cannot filter by Job/Phase.

If the job has no budget at all, no filter is available.

If you set up a job with phases, and each phase has a budget, the search yields only cost codes included in
the budget for that job and phase. If the job has a budget but no phases, the search yields only the cost codes
for the job. If there is no budget, the resulting list includes all the cost codes in your company database.

Filtering rules also apply to cost divisions. If the budget has no cost codes for site work and you select the site
work division, the search yields no results. To see the site work cost codes, youmust switch the filter to All .

New Option for Company-Specific Custom Reports and Forms
You can now create reports and forms for a specific company that are accessible to all users when they print
reports for that company.

Tomodify an existing company-specific report or form, later, select Display Company Reports orDisplay
Company Forms.

Company-specific reports and forms are located in theSage100Con > Company > [company] > Files >
Custom Reports or theSage100Con > Company > [company] > Files > Custom Report Forms folder,
respectively.

Use a new standard calendar to select dates
Sage 100 Contractor now displays a standard calendar as the date picker for date fields.
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To select a date:
1. Press F5 or click theDisplay calendar button in a date field, or select Display calendar from the

shortcut menu on a date cell in a grid.

If you selected a date previously, that date is highlighted in the calendar.

2. Double-click the date you want to use.

You are returned to the date field, which now displays the date you selected.

Tip: If you prefer to use the old company calendar, simply press F2 after clicking in the date field.

Support for Customized Tables and Views
Administrators and third-party developers can now add customized tables and views to Sage 100 Contractor
databases. Sage 100 Contractor reserves a special namespace designation for customizations, preventing
potential conflicts with future software development, or the creation of incompatible customizations.

Before you can add tables and views, youmust create a schemawith a name that begins with dbx_ to identify
it as a custom schema. Dbx_ should be followed by your company name or another unique label that will
distinguish it from other third-party schemas. For example, Rupert Everett Consulting could create a schema
called dbx_REVERETT.

You can then add tables and views to this schema, and you can addmultiple schemas, as needed.

More versatile Lookup windows
Sage 100 Contractor provides a consistent and versatile set of enhanced Lookup windows throughout the
program

Using the new Lookup windows, you can view information and select records in convenient new ways,
including:

Choose columns to display or hide in a Lookup window.

On theOptionsmenu in any Lookup window, click Select Columns to Show, then select the check
boxes for each column you want to display in the Lookup window, or clear the check box to hide a
column from view.

View the names associated with columns that display certain numbered records, for example, the
vendor names for vendor numbers, job names for job numbers, account names for account numbers,
and so on.

Sage 100 Contractor displays name columns automatically for these numbered records, identifying
them by enclosing the column heading in parentheses, for example "(Vendor Name)."

Note: You cannot hide these name columns while the associated number column is displayed,
although you canminimize the columnwidth by dragging the right edge of the column header. If
you hide a number column, the associated name column is also hidden.
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Change the order in which columns appear in a Lookup window.

Simply grab the column heading for a column you want to move, then drag it left or right until it is
positioned where you want it to be.

Note: If you separate a name column from its associated number column, the Lookup window
does not retain the new position the next time you open the Lookup window. The name column
always appears beside its associated number columnwhen you open any Lookup window.

View more accurate results, and find records more quickly, when you begin typing a search term in a
data control box.

The new Lookup windows display only the records that begin with the characters you type, filtering
evenmore effectively as you continue typing.

When you see the record you want, select it on the list, and then press [Enter] to use it in the
transaction or other window you were working with.

When you close the window, Sage 100 Contractor automatically saves your display preferences, so columns
appear as you want them the next time you use Lookup features in that window.

Enhancements for the U.S. Edition
n TheSales Tax Districtswindow now includes a column to show the effective tax rate for each tax district.
You can also add this column to the Tax Districts lookup window using theOptions > Select Columns to
Show option in the lookup window.

Summary of Enhancements in Earlier Versions of Sage 100 Contractor
(SQL)
The following table is a comprehensive list of features introduced in earlier versions, details of which you can
read about in the Release Notes for the respective version.

Version Enhancement U.S.
Only

Canada
Only API

Details for version 20.5 enhancements are available in the Version 20.5 Release
Notes

V20.5 We implemented a variety of customer-sug-
gested enhancements.

V20.5 You can use new custom fields in most windows

V20.5 You can tag rows for follow‐up in the 9‐5 Takeoffs
grid

V20.5 Audit Information is available in Advanced
Company Settings

V20.5 Numeric fields provide automatic calculation
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Version Enhancement U.S.
Only

Canada
Only API

V20.5 You have easier access to user subfolders in
workgroups

V20.5 You can correct the period of a posted payroll
transaction

V20.5 You can skip automatic calculation during takeoff

V20.5 You can filter cost codes by Job and Phase in
lookup windows

V20.5 You can filter unassigned work orders on the
Dispatch Board

V20.5 There is a new option for saving and selecting
company-specific custom reports and forms

V20.5 You can use a new standard calendar to select
dates

V20.5 Version 20.5 supports Microsoft SQL Server 2016
andWindows 2016 Server

V20.5 You can copy user process maps

V20.5 You can use high contrast display settings for
Windows 10

V20.5 You can print a new Payroll Check Register 5‐1‐2‐
31 by check date

V20.5 3‐7 Progress Billing and 12‐2 Inventory Allocation
allow 5,000 rows

V20.5 Tax andWorkers' Comp rates in 4‐4 and 4‐2 use 4
decimal places X

V20.5 Workers' CompReports 21, 86, and 96 show
Overtime Hours X

Details for version 20.4 enhancements are available in the Version 20.4 Release
Notes

v20.4 You can copy external files to other users

v20.4 There is a new option to approve the removal of
employee records

Details for version 20.3 enhancements are available in the Version 20.3 Release
Notes

v20.3  You can view change history in records
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Version Enhancement U.S.
Only

Canada
Only API

v20.3  There is a new option for closing purchase orders
automatically

v20.3  Version 20.3 supports Sage Exchange Desktop 2.0

v20.3  Version 20.3 supports customized tables and views 

v20.3  You can use a new window to add client service
locations quickly

v20.3  Effective Rate Shown for Sales Tax Districts (U.S.
only) X

v20.3  API supports adding and removing attachments X

v20.3  API Enforces Locks X

v20.3  SchemaChange for Global Variables X

Details for version 20.2 enhancements are available in the Version 20.2 Release
Notes

v20.2  Simplified schedules lookup

v20.2  QueryJobCost (API Enhancement) X

v20.2  SetExclusive (API Enhancement) X

Details for version 20.1 enhancements are available in the Version 20.1 Release
Notes

v20.1 More versatile lookup windows

v20.1 Unique Payroll record numbers

Notes for Third-Party Developers
API Support for Adding and Removing Attachments

The API supports adding and removing attachments on all Sage 100 Contractor forms that support
attachments and have API support forAdd,Modify, andDelete.

As with the existing API forWork Orders, these changes do not include support for:

Changing the description on attachments

Web links

Other API enhancements include:
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Migrating your company data from version 19.8
Important! Youmust be using Sage 100 Contractor version 19.8 tomigrate your company to version
20.6. If you are using an earlier version of Sage 100 Contractor, youmust first upgrade your company data
to version 19.8.

You use themigration utility in the new Database Administration tool to automatically migrate and upgrade
your data to version 20.6, including all company data in folders and subfolders of…\MB7\[CompanyName].

Migrated files are located in shared folders under \\ServerName\CompanyName. These subfolders are
organized using a similar folder structure as in earlier versions, and include:

Aatrix Forms

Attachments

Direct Deposit

Images

Reports

The Direct Deposit and Reports folders are available as soon as you open the company in Sage 100
Contractor. The remaining folders are created as needed.

Note: For detailed, step-by-step instructions onmigration, see the Database and Company
Administration Guide or the Database Administration help.

Preparing for migration in version 19.8
Migration should proceed smoothly in most cases. However, you should audit your accounting data and your
company payroll in version 19.8, and then fix any errors, before attemptingmigration to version 20.6.

Use the following audit tools to prepare your data in version 19.8:

1-6 Period and Fiscal Year Management > Audit Books

5-3-7 Payroll Audit

6-6-3 PurchaseOrder Audit

6-7-4 Subcontract Audit

12-5 Inventory Audit

Note: If your data includes serious audit errors, youmay need assistance from your business partner or
consultant to prepare your database for migration.

Upgrading from version 19.8?
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Migrating reports
The new Database Administration tool also includes a utility to migrate and upgrade Sage 100 Contractor
reports and reports written with the Sage 100 Contractor report designer.

In version 20.6, shared custom reports and form designs are located in these folders:

\\ServerName\Sage100Contractor\Custom Reports

\\ServerName\Sage100Contractor\Report Forms

Private custom reports and form designs are located in Sage 100 Contractor User Data folders associated
with each user name, as follows:

\\ServerName\Sage100Contractor\User Data\username\Custom Reports

\\ServerName\Sage100Contractor\User Data\username\Report Forms

Updating custom reports
You also need to update custom reports created with third-party software, such as Crystal Reports, so they
map to the new database.

We recommend that you use the new report views that comewith version 20.6 to create or update reports.
The new views were created for your convenience, so that future database changes will not necessarily break
your custom reports.

After migrating your company data
After migrating your data, you will likely need to perform the following additional steps to prepare your
company for use in Sage 100 Contractor:

Important! UseDatabase Administration, not SQL Server Management Studio, for all these tasks.

Add company administrators. There is no longer a generic "supervisor" user as there was in earlier
versions. All users must sign into the company using their personal IDs, and only users designated
as company administrators have heightened privileges previously associated with the "supervisor"
role. You can designate one user as a company administrator duringmigration, but you can add
others later.

Add SQL logins for new users. If you have new users that did not exist in your version 19.8
company, add them as users to the SQL database.

Youmust also add them as users and assign security in Sage 100 Contractor.

Migrating your company data from version 19.8
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Designate an additional SQL Server administrator. Only a user with system administrator
privileges for the SQL instance can administer users for SQL Server or assign the system
administrator role to another user. Therefore, it is vital at all times that more than one user has a
system administrator role. If the principal system administrator should suddenly fall ill, or leave your
company, or otherwise be unable to perform their duties, another person with administrative access
to the SQL Server databasemust be able to take over that role.

Note: The person who installs Sage 100 Contractor is automatically assigned a 'sysadmin' role
in SQL Server. When they designate a SQL Server administrator in Database Administration,
that person is also assigned the 'sysadmin' role in SQL Server.

Switch your Sage Construction Anywhere to version 20.6. If you have been using Sage
Construction Anywhere with Sage 100 Contractor version 19.8 and want to use it with version 20.6,
you will need to switch the connection to version 20.6. For help on switching the connection, see the
instructions in the Installation and License Administration Guide.

Migrate your Sage ACT! settings to version 20.6. If you have been using Sage ACT! with Sage
100 Contractor version 19.8 and want to use it with version 20.6, you need to change your ACT!
settings to point to your new version 20.6 company database. For help onmigrating your ACT!
settings to version 20.6, see the instructions in the Installation and License Administration Guide.

Migrate each user's scheduled reports from version 19.8. See the instructions in the Installation
and License Administration Guide.

Migrate each user's alerts from version 19.8. See the instructions in the Installation and License
Administration Guide.

Changes to converted data
Duringmigration, the programmay encounter problems that might prevent it from writing a particular record to
the new SQLServer database.

If the problem is one that themigration program can fix, it repairs the record, and then writes the updated
record to the SQL Server database. (For a list of the types of errors that can be fixed duringmigration, see the
Database and Company Administration Guide.)

Note: Not all errors can be fixed duringmigration. In these cases, the record is not written to the new
database.

The migration log file

The program keeps a log of all changed records and records that were not migrated because of an
unresolvable error, unless the record was invalid in version 19.8. (Invalid records are neither migrated nor
logged.)

After migration, you should check the log file to see what changes weremade to your data during conversion,
or whether any records were not migrated to the new SQL database.

The _SQL_MIGRATION_LOG.TXT file is located in the source company's main folder (for example,
C:\MB7\Sample Company). A supplemental file, _SQL_MIGRATION_LOG_VERBOSE.TXT, includes more
detailed information about each error found.

Upgrading from version 19.8?

31 Sage 100 Contractor



Using Sage 100 Contractor Intelligence Reporting with Sage 100
Contractor 2017
Sage 100 Contractor Intelligence Reporting versions 20.2 and 19.7 are not designed to work side-by-side.

If you used Sage Intelligence Reporting with Sage 100 Contractor version 19.8 or earlier, follow the steps in
Knowledgebase article 75640 when upgrading to version 20.6.

Migrating your company data from version 19.8

Release Notes 32

https://support.na.sage.com/selfservice/viewdocument.do?externalId=75640


Known Issues and Comments
The following sections describe known issues and problems in Sage 100 Contractor Version 20.6.

General

Internet access required for Sage 100 Contractor
Sage 100 Contractor features, such as printing or efiling tax forms, submitting enhancement requests,
accessing Help, or downloading periodic product or tax updates all require Internet access.

To take advantage of these features, ensure that any workstation or server that Sage 100 Contractor is
installed on has access to the Internet.

During installation of Sage 100 Contractor, the computer serving as the Sage license server must be able to
connect to the Internet to obtain licenses. Once installation is complete, you can check out license uses for
each computer where Sage 100 Contractor is installed, then disconnect the Sage license server from the
Internet.

Note: A static Internet connection using a compatible web browser is required for Sage Construction
Anywhere. For current information on supported browsers, supported Sage 100 Contractor versions, and
other system requirements, see the Sage Construction Anywhere help at
http://help.sageconstructionanywhere.com/sage100contractor/help/Default.htm#01_Setup/System_
requirements.htm.

Configuring anti-virus software and third-party firewalls
During installation of the Sage 100 Contractor Hosting Framework, theWindows Firewall is configured
automatically to allow the Sage 100 Contractor Hosting Framework to act as a TCP server. If you use some
other firewall, however, youmay need tomanually adjust some settings in the firewall in order to ensure
proper operation.

You can use the following basic procedure tomanually configure theWindows Firewall to allow the Sage 100
Contractor Hosting Framework to communicate with other computers. Use it as the basis for manually
configuring other third-party firewall products.

To configure the Windows Firewall:
1. ForWindows Server 2008, click Start > Control Panel > Security.

ForWindows 7, click Start > Control Panel > System and Security.

ForWindows 8.1 andWindows 10, click Start > All apps > Control Panel > System and Security.

2. OpenWindows Firewall, and then select Allow a program or feature through Windows Firewall.

3. Select Sage 100 Contractor Hosting Framework on the list, if it is not selected..

Note: By default, the exception is set to allow access by any computer on the network. You can refine
this setting by selecting theChange Scope button. Be aware that restricting the scope incorrectly can
cause the computer to be unable to connect with some or all of the other machines on the network.
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Files to exclude when manually configuring your firewall for Windows 8.1 Professional
32-bit

C:\ProgramData\Sage\Sage 100 Contractor

C:\Program Files\Sage\Sage 100 Contractor

C:\ProgramData\Aatrix Software

C:\Program Files\Aatrix Software

C:\%LocalAppData%\Sage\Sage 100 Contractor

Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database
Administration, this location is C:\Sage100Con\Company\.)

Files to exclude when manually configuring your firewall for Windows 8.1 Professional
64-bit

C:\ProgramData\Sage\Sage 100 Contractor

C:\Program Files (x86)\Sage\Sage 100 Contractor

C:\Program Files (x86)\Aatrix Software

C:\ProgramData\Aatrix Software

C:\%LocalAppData%\Sage\Sage 100 Contractor

Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database
Administration, this location is C:\Sage100Con\Company\.)

Files to exclude when manually configuring your firewall for Windows 7 Professional 32-bit
C:\ProgramData\Sage\Sage 100 Contractor

C:\Program Files\Sage\Sage 100 Contractor

C:\ProgramData\Aatrix Software

C:\Program Files\Aatrix Software

C:\%LocalAppData%\Sage\Sage 100 Contractor

Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database
Administration, this location is C:\Sage100Con\Company\.)

Files to exclude when manually configuring your firewall for Windows 7 Professional 64-bit
C:\ProgramData\Sage\Sage 100 Contractor

C:\Program Files (x86)\Sage\Sage 100 Contractor

C:\Program Files (x86)\Aatrix Software

C:\ProgramData\Aatrix Software

C:\%LocalAppData%\Sage\Sage 100 Contractor

Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database
Administration, this location is C:\Sage100Con\Company\.)

General

Release Notes 34



Files to exclude when manually configuring your firewall for Windows 8.1 Professional
C:\ProgramData\Sage\Sage 100 Contractor

C:\Program Files (x86)\Sage\Sage 100 Contractor

C:\Program Files (x86)\Aatrix Software

C:\ProgramData\Aatrix Software

C:\%LocalAppData%\Sage\Sage 100 Contractor

Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database
Administration, this location is C:\Sage100Con\Company\.)

Files to exclude when manually configuring your firewall for Windows Server 2008 R2,
2011, 2012

C:\ProgramData\Sage\Sage 100 Contractor

C:\ProgramFiles (x86)\Sage\Sage 100 Contractor

C:\Program Files (x86)\Aatrix Software

C:\ProgramData\Aatrix Software

C:\%LocalAppData%\Sage\Sage 100 Contractor

Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database
Administration, this location is C:\Sage100Con\Company\.)

Software and hardware required to support Microsoft SQL Server
Version 20.6 requires an instance of Microsoft SQL Server. You can download and useMicrosoft SQL
Express at no charge, or you can use the full version of Microsoft SQL Server. You can even start using
Microsoft SQL Express, and upgrade to the full version of Microsoft SQL Server later, if necessary.

When you first open the new Database Administration tool, the program tries to configure an instance of
Microsoft SQL Server with optimal settings for Sage 100 Contractor for you. If you do not already have an
instance of Microsoft SQL Server, you can let the Database Administration tool download, install, and
configureMicrosoft SQL Express for you.

Refer to Knowledgebase article 84502 for detailed information about supported operating systems and
software, and for minimum hardware requirements.

Installation of Microsoft SQL Server on a domain controller is not
recommended
Microsoft recommends against installing SQL Server on a domain controller, and does not support SQL
Server on a read-only domain controller should you encounter any problems with this configuration.

Because youmust install Database Administration on the samemachine as SQL Server, you should not
install Database Administration on a domain controller. To guard against inadvertent installation on a domain
controller and the potential for irrecoverable data losses, you will receive a warning if you attempt to install
Database Administration on amachine used as a domain controller .
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Formore information, see theMicrosoft Knowledgebase article https://support.microsoft.com/en-
us/kb/2032911.

About .NET Framework
.NET 4.6.1 Framework is required

If Microsoft .NET 4.6.1 Framework is not already installed, it will be installed automatically when you install
Sage 100 Contractor. Installation of .NET 4.6.1 Framework alonemay take up to 20minutes per computer.

Make sure that both your client and server computers meet theminimum requirements for installing both Sage
100 Contractor software and .NET 4.6.1 Framework.

Note: If Sage 100 Contractor requires an installation of .NET 4.6.1 Framework, the Sage 100 Contractor
installation process may continue automatically after the .NET Framework installation is completed. If
you are prompted to restart your computer after the .NET Framework installation, youmust do so to
continue the Sage 100 Contractor installation.

.NET 3.5 is also required

In some situations, youmay need to turn on .NET 3.5manually by selecting the .NET 3.5 check box in the
Windows Features dialog box. For more information, see Knowledgebase article ID 68381, available at
https://support.na.sage.com/selfservice/viewdocument.do?externalId=68381.

Windows Small Business Server 2011 is not supported

Microsoft Small Business Server 2011 does not support .NET Framework 4.6.7, which Sage 100 Contractor
(SQL) requires. Unfortunately, this means that Sage 100 Contractor (SQL) cannot support Small Business
Server 2011.

Turning on Microsoft .NET 3.5

Microsoft .NET 3.5must be available and enabled prior to installing Sage 100 Contractor on aWindows
Server 2008 R2machine. Server 2008 R2 comes with .NET 3.5 loaded but not installed, so Sage 100
Contractor does not install it automatically.

If you attempt to install Sage 100 Contractor without .NET 3.5 installed, you receive the followingmessage
during the licensing install: “Sage.CRE.HostingFramework.Service v3.2 has stopped working.”When you
click [OK], the installation continues, but the services have not been installed so Sage 100 Contractor cannot
open. The Sage.CRE.HostingFramework Service will not install unless .NET 3.5 has been installed. If you
receive the abovemessage during installation, install .NET Framework 3.5., and then reinstall Sage 100
Contractor.

The following instructions are forWindows Server 2008 R2.

To verify that .NET 3.5 is installed on Windows Server 2008 R2:
1. Click theStart button in the lower left corner of the display.

2. Highlight Administrative Tools and select Server Manager.

3. In theServer Manager interface, click Features to display all the installed Features in the right-hand
pane. Verify that .NET Framework 3.5.1 is listed.
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To enable .NET 3.5 on Windows Server 2008 R2:
1. In theServer Manager interface, select Add Features to display a list of possible features.

2. In theSelect Features interface, expand .NET Framework 3.5.1 Features.

3. Once you expand .NET Framework 3.5.1 Features, you will see two check boxes. Check the box next
to .NET Framework 3.5.1 and click Next.

4. In theConfirm Installation Selections interface, review the selections and then click [Install].

5. Allow the installation process to complete and then click [Close].

Note: Enabling .NET Framework 3.5.1may require a reboot.

About network configuration and TCP Remoting Channel
Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component, to enable
communication among computers on a network. By default, Sage 100 Contractor uses the TCP starting port
48750. Certain configurations can potentially disable the communication:

Youmust enable file sharing on your computers. To enable file sharing, follow the instructions in the
Windows Help.

TCP communication requires the selection of port numbers that are not in use by other processes on
the local computer.

Software firewalls running on the local computer can be configured to block processes from opening
TCP ports, which will prevent communication through the TCP Remoting Channel.

Sage Advisor Update

Important! Sage Advisor Update is not available for version 20.5, until further notice.

You can download Version 20.6 from the Knowledgebase using the link provided in Software Notice 17-D.

PCI DSS Compliance
PCI DSS stands for Payment Card Industry Data Security Standard. It was developed by themajor credit
card companies as a guideline to help organizations that process card payments to prevent credit card fraud,
cracking, and other security weaknesses and threats.

A company processing, storing, or transmitting payment card datamust be PCI-compliant or risk losing its
ability to process credit card payments and being audited and/or fined. (For more information about PCI
standards, see https://www.pcisecuritystandards.org/.)

Sage 100 Contractor payment processing works exclusively with Sage Payment Solutions to enable
merchants to seamlessly process check and credit card transactions directly in Sage 100 Contractor. The
payment processing program uses Sage Exchange, a secure payment-processing application, to connect to
Sage Payment Solutions and process check and credit card transactions.

Integrating your financial and operations system with Sage Payment Solutions lets you process check and
credit card transactions without storing your customers’ sensitive card information in your database. Sage
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Exchange transmits check and credit card details through a secure connection to Sage Payment Solutions,
where they are stored in a PCI-compliant vault, protecting your from exposure to non-compliance penalties
and credit card fraud.

Caution! To avoid non-compliance with PCI standards, do not store credit card information in Sage 100
Contractor. Such storage creates unnecessary risk for your business and your customers.

Using Sage 100 Contractor Intelligence Reporting with Sage 100
Contractor 2017
Sage 100 Contractor Intelligence Reporting versions 20.2 and 19.7 are not designed to work side-by-side.

If you used Sage Intelligence Reporting with Sage 100 Contractor version 19.8 or earlier, follow the steps in
Knowledgebase article 75640 when upgrading to version 20.6.

Tax Forms and eFiling by Aatrix configuration requirements
Tax Forms and eFiling by Aatrix requires an Internet connection for two reasons:

For updating forms and executable files.

For electronic filing (eFiling) of the forms.

If you experience an Internet connection problem, it may be due to problems communicating through an
Internet firewall. Firewalls need to have access allowed through specific ports:

The Tax Forms and eFiling Updater uses standard SSL/HTTP port 80 to access the site
http://updates.aatrix.com.

The eFiling component uses secure HTTPS on port 443 to access the site https://efile.aatrix.com.

By allowing access to aatrix.com, you allow both updates and eFiling. Occasionally, restrictions are tighter
and only allow access to these ports by specific programs. Tax Forms and eFiling uses the following
programs to access the Internet.

For updating using http on port 80 to http://updates.aatrix.com:

aatrixforms.exe

updater.exe

updater2.exe

For eFiling using secure http on port 443 to https://efile.aatrix.com:

builder.exe

viewer.exe

Printing reports at year-end (U.S. Edition)
As of Version 19.2, in the U.S. Edition, if you pay retainage in the current year for a prior year invoice and then
you print a 4 1 3 26 AP Aging report for the prior year, the report shows a reduced retainage amount, and the
amount paid in the future period is allocated to the Current period or an aging period, depending on the due date
of the retainage and the date it was paid.
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Therefore, you should print these reports as part of your year-end processing to ensure that you have a set of
reports that reflect the true amount of retainage outstanding at year end.

Tip: If you archive your data at year end, you can also print the reports from the archive company, later.

Printing reports to PDF or exporting to Excel?
When you print reports to PDF, youmay find that the size of the PDF file is unexpectedly large and the
resolution of the displayed PDF is not optimal.

To create a substantially smaller PDF file with good resolution, you can run Sage 100 Contractor in
Compatibility Mode (compatible withWindows 7), and then print the report.

Note: You cannot export to Microsoft Excel when running Sage 100 Contractor in Compatibility Mode if
you useMicrosoft Office 2013.

We have not encountered this issue during testing, nor has it been reported forWindows Server 2012 R2.

Use Adobe Reader Version 8.1.3 or later for faxing
Customers have reported problems faxing from Sage 100 Contractor with versions of Adobe Reader earlier
than 8.1.3. Adobe Reader Version 8.1.3 and later support faxing fromWindows and from Sage 100
Contractor.

Important! To fax from Sage 100 Contractor, theWindows Fax Service component must be installed
with yourWindows operating system. For more information about installing theWindows Fax Service
component, see the Sage 100 Contractor Help topic, “Installing theWindows Fax Service component.”

Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-
start on Windows 8.1, Windows 7 Professional, Server 2008, or Server
2008 R2 Standard
The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers
running theWindows 8.1, Windows 7 Professional, Server 2008, or Server 2008 R2 Standard operating
systems. If the service stops, the program displays amessage advising you to take further action to resolve
this issue.

Configuring Windows Regional and Short Date Format
To specify regional formats for Windows:
1. Click the [Start] button, point toControl Panel, then click Clock, Language, and Region .

2. Click Region and Language.

3. On the Formats tab, select the format for your country.

4. UnderDate and time formats, from the Short date format drop-down list, select the format used for
your country.
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5. Click [OK].

6. Close theClock, Language, and Regionwindow.

Posting Status for a Company Created since Version 19.2
If you created a new company using version 19.2, or higher, in certain limited scenarios an issue can arise
after you advance the year to the first period of the new fiscal year. The new year may not be available when
you try to change the posting period.

A fix to prevent this issue is included in the January 2015 update. However, if you have already encountered
this issue, contact Customer Support for assistance.

Windows "Sleep Mode" prevents computers from obtaining a license use
If the computer you are using as a license server goes into sleepmode, other computers on the network
cannot obtain a license.

To avoid this possibility, set Sleep Mode on your license server computer toNever.

To set the Sleep Mode to “Never”:
1. InWindows 8.1 Professional, Windows 10, or Server 2012 Standard, click Start > All apps > Control

Panel > System and Security > Power Options.

InWindows 7, click Start > Control Panel > System and Security > Power Options

2. Select Change when computer sleeps.

3. From thePut computer to sleep list, select Never.

Windows 8.1 Professional and Server 2012 Standard
Operating Systems

Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-
start on Windows 8.1
The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers
running theWindows 8.1 Professional orWindows 8.1 Enterprise operating systems. If the service stops, the
program displays amessage advising you to take further action to resolve this issue.

Server 2012 network configuration and TCP Remoting Channel
Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component to enable
communication among computers on a network. File and printer sharing on computers running the Server
2012 operating systemmust be enabled. To enable file sharing, follow the instructions in theWindows Server
2012 Help.

Windows 8.1 Professional and Server 2012 Standard Operating Systems
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Windows 7 Professional and Server 2008 R2 Standard
Operating Systems

Launching Sage 100 Contractor to run as administrator for scheduling
reports

Important! On computers runningWindows 7 Professional or Server 2008 R2 Standard, scheduling
Sage 100 Contractor reports requires that you “run as administrator” or to “run the program as
administrator.”

Microsoft Windows changed security rules in theWindows 7 Professional and Server 2008 R2 Standard
operating systems tomake your computer more secure. If you are running Sage 100 Contractor as a typical
user, then you have limited privileges in some areas of the program, such as saving a report schedule. To
save a report schedule, youmust launch Sage 100 Contractor with the command to eitherRun as
administrator orRun this program as an administrator.

When you select either command, the settings are limited to you personally. Your settings to run Sage 100
Contractor as administrator do not affect the next person who logs on and launches Sage 100 Contractor from
this computer. Your settings on this computer can either be temporary or persistent. For example, when you
select Run as administrator, you run the program as administrator for that session only. When you select Run
this program as an administrator, you set program properties to always run the program as administrator
when you log on to this computer.

Note: "Run as administrator" and "Run this program as an administrator" are not related to
Windows 7 Professional or Server 2008 R2 Standard operating systems user groups but are limited to a
specific program you are running.

To set "Run as administrator":
1. On yourWindows desktop, right-click the Sage 100 Contractor program icon.

2. From the drop-downmenu, to launch the program, click Run as administrator.

Note: SelectingRun as administrator only runs the current session of running Sage 100 Contractor.
The setting does not persist after the session is over.

To set "Run this program as an administrator":
1. On yourWindows desktop, right-click the Sage 100 Contractor program icon.

2. From the drop-downmenu, click Properties.

3. On the Sage 100 Contractor Properties window, click theCompatibility tab.

4. Under Privileges Level, select Run this program as an administrator.

5. Click [Apply], and then click [OK].

Known Issues and Comments

41 Sage 100 Contractor



Note: SelectingRun this program as an administrator always runs the program with these properties
when you launch the program on this computer. The setting persists.

Solution for Windows Server 2008 R2 "Permission Error Opening File"
If you see a permission error message when launching Sage 100 Contractor on a computer running the
Windows Server 2008 R2 operating system, follow these instructions:

1. On theWindow desktop, right-click Start, and then click Open Windows Explorer.

2. On the left side of the window, underComputer > Local Disk, right-click the \Sage100Con folder, and
then select Properties.

3. On theSage100Con Propertieswindow, click theSecurity tab.

4. From the list underGroup or User Names, select USERS, and then click theEdit button.

5. On thePermissionswindow, select USERS again, and underAllow, select the Full control check
box.

Selecting Full control selects all the check boxes necessary for this solution.

6. On thePermissionswindow, click [OK].

7. On theSage100Con Propertieswindow, click [OK].

Solution for Windows 2008 Server R2 Application Error Message
Under some circumstances, on servers operatingWindows 2008 Server R2, youmay see the following error
message when trying to open a photograph or image file in Sage 100 Contractor:

"No application is associated with the specific file associated with this application."

This error message appears when you attempt to open an image file in Sage 100 Contractor but you have not
yet enabled the Desktop Experience feature inWindows 2008 Server R2. If you receive this error message,
install Desktop Experience using the Server Manager utility:

1. InWindows 2008 Server R2, select Start > All Programs > Administrative Tools > Server
Manager.

2. In theServer Managerwindow, click Features (left-hand pane).

3. In the Features pane, click Add Features.

4. Select the Desktop Experience check box.

5. If you are prompted to add additional features, click [Add Required Features].

6. Click [Next].

7. Click [Install].

Windows 7 Professional and Server 2008 R2 Standard Operating Systems
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